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“October is the fallen 

leaf, but it is also a 
wider horizon more 
clearly seen. It is the 
distant hills once 
more in sight, and 
the enduring constel-
lations above them 
once again. “  Hal Borland 

We are pleased to  

welcome  new editors:  

Barb Husband and  

Moira Fenner to the 

Monitor  
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CONGRATULATIONS 

In the The Monitor  section, NPC Featured Photographer, 
we become better acquainted with other members of our club, 
see their work, and gain insight into how and why they devel-
oped an interest in photography.  We should not forget howev-
er, that our members are multi talented and have other skills 
besides photography.  One such member, who has shown that 
his talent is more than just that of a fine photographer, is Da-
vid O'Rourke.   

 

During the pandemic, David  returned to an old love, writing, 
finishing the revision of a novel entitled Home and Away, 
and receiving word that his academic book, Once There Were 
Giants: The Modern Montreal Poets Who Set Out to Build a 
National Literature, would be published in May 2021 by To-
ronto’s Cormorant Books. 

 
Here is the publisher’s description of the latter book:  

“Like the Group of 7 did in Canadian art, the Montreal poets of 
the 40s, including people such as John Sutherland (Donald Suth-
erland’s half-brother), Irving Layton, and F.R. Scott, took the 
first steps towards consciously building a Canadian Literature 
and, in so doing, laid down the foundation for our literary cul-
ture. The book offers a series of interviews with the participants, 
creating a vivid oral history of the period. The story that evolves 
is akin to a novel - complete with literary rivalries, cold garrets, 
love affairs, and great poetry. Samples of the poetry of these gi-
ants complete the book along with an introduction, timeline and 

essays by David O’Rourke.” 

We wish David equal success with his novel Home and Away (not to mention 
the arrival of his new puppy Emma on September 22nd)!  I am sure we are all 
anxious to get our hands on a copy of David's book when it becomes available 
and have it signed by the author. 

David O’Rourke 
By Ray Williams 
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Dan Milligan 

Cobourg Sports Hall of Fame Inductee 
By Janet Taylor 

 

Many of you know Dan Milligan as a fellow photographer, former publisher of 
The Monitor, and gregarious member of the Northumberland Photography Club. 
He is all of those things and more.   

 

This past March 2020, Dan was inducted into the Cobourg Sports Hall of Fame 
for his work and performance in lawn bowling. . 

 

Over the years, Dan has represented Canada internationally, and many times 
competed at the national and provincial levels. He has been the National Coach-
ing Chairperson, and was the National Team Coach at the Commonwealth 
Games at Victoria, British Columbia. He is the highest ranked bowls coach in 
Canada.  

 

Dan has  been a very generous benefactor at the local level as well.  He and his 
family support Cobourg Youth Lawn Bowling, and sponsor some of the 
Cobourg Lawn Bowling Club tournaments.  

 

NPC SLIDESHOWS 
 

The Slideshow videos are uploaded for viewing on our NPC Northumberland Photography Club 
YouTube Channel each month.  They can be viewed for approximately two weeks by clicking on this 
link -  https://www.youtube.com/channel/UCqLhPuUuANglDsLVNYJpIGA/featured  

 

Thank you Terry Carpenter who created a wonderful member's monthly slideshow made from contri-
butions of our talented and enthusiastic photographers in the month of September.  

 

We also had 3 individual slideshow submissions, Stan Kicak, Bryan Marjoram, and Donna Edmonds. 
Let's see your own individual slideshow in the months to come!  

 

Thank you for your contributions and thank you for watching! 

  

CONGRATULATIONS 

https://www.youtube.com/channel/UCqLhPuUuANglDsLVNYJpIGA/featured
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FEATURED PHOTOGRAPHER 

ELISABETH LA FONTAINE 

. 

Elisabeth was born in Ceylon, now Sri Lanka, the daughter of a 
British couple.  

Her father managed a 2,000 acre tea estate and was a keen photog-
rapher. Her mother was a “hobby farmer” to pass the time as 
neighbours were few and far between. She grew vegetables and 
flowers to fulfil orders in Colombo. These went twice a week on 
the night train. She had cows to provide milk for the house, the 
hospital and estate assistants. She raised chickens, ducks, geese and 
rabbits for the hotel trade. So Elisabeth was brought up with 
“nature” on her doorstep. 

 

 

 

 

Elisabeth at School 

Elisabeth was given a Box Brownie when she was eight years old and although she spent time with her fa-
ther in his dark-room she didn’t have a lot of interest in photography. 

Continued... 
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Featured Photographer continued... 

 

Elisabeth was educated in Scotland, lived in England and moved with her husband, twin sons and daughter 
to Canada in 1977. After a year living in Saudi Arabia she returned to Canada and founded an International 
Conference and Event Management Company in Toronto. This took her all over the USA, Canada, Europe 
and Hong Kong and she was Director of The Canada Japan Business Committee for Bilateral Trade Talks. 
Their annual conferences were held alternately in Canada and Japan so she had an opportunity to visit Ja-
pan nine times. 

When SARS hit Toronto in 2003 
most Conference Management 
companies closed down due 
tolack of travel to Canada. Elisa-
beth retired and moved to Graf-
ton. She felt that she had returned 
toher roots: Country living! She 
is surrounded by acres of forests, 
farms and the shores of Lake 

Ontario only are a stones-throw 
from home. It was time to take up 
the passion for photographythat 
had evaded her for so many 
years. She took several courses – 
although she’s never mastered the 
math involved! Her large garden 
provides a backdrop for her pho-
tography. Flowers, insects, 

butterflies, spiders, birds, squir-
rels and chipmunks abound. On 
occasion she even welcomes larg-
er visitors - raccoons, deer, foxes 
and coyotes. 

 
Continued... 



 6 

OCTOBER 2020 

Featured Photographer continued... 
 

 
 

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

This summer, Elisabeth took a 

course, “Macro Masters in Ar-

tistic Floral Photography” run 

by Jackie Kramer 

(Phlorography – Artistic Floral 

Photography on Facebook). 

This course, a series of 14 pre-

senters on Zoom, included not 

only many new photographic 

techniques but also introduced 

some of the magic that can be 

achieved with the use of a 

smartphone camera! She is 

now hooked a) to Zoom work-

shops and b) to SmartPhone 

photography! Enjoy these re-

cent photographs! 

It was Elisabeth’s first meeting with 
Don Komarechka of Snow-Flake pho-
tography fame, some six years ago, that 
sealed the direction her photography 
would take – the world of macro. She 

took several of his workshops and at-
tended talks in person and online.  

“Don Komarechka is a nature, macro and landscape 
photographer located in Barrie Ontario. From auro-
ras to pollen, insects to infrared, much of Don’s 
photographic adventures reveal a deeper under-
standing of how the universe works”. (Taken from 
Don’s website). Elisabeth now has the pleasure of 
proof-reading Don’s book, on the brink of publica-
tion, “Macro Photography – The Universe at our 
Feet”. This will undoubtedly become the definitive 
book on Macro Photography. 

Elisabeth La Fontaine 
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NATURE PHOTOGRAPHY 

BY  ELISABETH LA FONTAINE 

 

PETER’S WOODS PROVINCIAL NATURE RESERVE 

 

 

 

 

Continued... 

The approach of Fall brings with it a plethora of mushrooms and 
toadstools in gardens and  woodlands. Peter’s Woods Provincial 
Nature Reserve provides enough examples of these to keep photog-
raphers happy. Tread carefully, they abound on the footpaths, on 
fallen trees and high up on some of the old growth trees. 

“This Reserve has been selected to represent and protect distinctive 
wildlife, natural habitat, bedrock of landforms of the Province. You 
will find a small remnant of a near virgin maple-beech forest simi-
lar to that which once covered many parts of Southern Ontario. 
Willow Beach Field Naturalists has devoted time and capital to the 
establishment of this nature reserve.” 

Click here for more information: Willow Beach Field Naturalists 

Photos on this page by Donna Edmonds 

https://willowbeachfieldnaturalists.org/peters-woods/#:~:text=A%20nature%20Reserve%20is%20a%20Provincial%20Park%20selected,12%2C000%20years%20ago%20during%20the%20last%20ice%20age.
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Nature Photography continued–  

 

 

 

 

 

 

 

 

 

 

 

 

 

There are four classes of mushrooms, some are 
edible, many are poisonous and caution is im-
perative. Leave them to happily do their job. 

Parasitic grow on a live host and often kill 
the tree or plant. 

Endophytic fungi live within the host plant 
without injuring it. 

Mycorrhizal mushrooms have a mutually 
beneficial bond with their host. 

Saprophytic mushrooms decomposed ead 
trees and plants and help build humus in 
the soil. 

Many members of the Northum-
berland Photography Club will 
have visited Peter’s Woods and be 
familiar with it in spring and sum-
mer but the best time to visit, for 
interesting photographs, is the Fall. 
If you have never ventured into the 
Old Growth Forest, now is the time 
to take your camera and tread very 
carefully! 

Photos on this page by Leslie Abrams 

 Continued... 
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Nature Photography continued–  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Peter’s Wood Provincial Nature 
Reserve, Roseneath Ontario 
992 McDonald Rd, Roseneath, 
ON K0K 2X0, Canada 

Mushrooms are important in the process of decomposition 
and this will be seen in Peter’s Woods as they grow out of 
the trunks and roots of fallen trees. 

Donna Edmonds, Leslie Abram and I spent a wonderful afternoon exploring the magical world of mush-
rooms. Donna and Leslie were able to turn themselves inside out and get under these tiny mushrooms to 
get photographs of the gills. I, on the other hand took the easy route and photographed the ones that could 
be approached from above! There’s something for everyone at Peter’s Woods so don’t leave it too late to 
go and explore before the snow falls.  

Photos on this page by Elisabeth La Fontaine 
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FASCINATING CUBA 
BY TERRY W SELF 

A wonderful island to visit offering 
beaches, countryside, villages and 
cities. For the best photo opportuni-
ties, visit the 500+ year old cities of 
Havana or Santiago. 
  

 

My preference has been Santiago for the last 20 years and several stays in hotels and Casa Particulars 
(B&B). I prefer to see the city and  meet people at my own pace on foot.  
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Continued:  

 

Over the years, not too much changed, that is, until Hurricane Sandy hit. One change is a pedestrian-
only street from Plaza de Marte,  winding downward through shopping areas, restaurants, galleries, 
passing the city centre, for over 2km to the port lands. Here are parks with sculptures, playgrounds, etc. 
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Most people I meet on my 
wanderings let me photo-
graph them. Some ask to be 
photographed. No money is 
asked.  
  

An interesting area is the area of mansions surrounding the Bacardi mansion (rum business started here). 
These are now private residences, schools, galleries and restaurants.  Carnival takes place with music and 
parades occurring in the week of July 26. Great to see and photograph. 
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I’m invited into their 
homes to see how 
they live and I spend 
much time with my 
Cuban friends in their 
homes, and enjoy 
their cooking. (No, I 
don’t speak Spanish). 
Several historical 
sites, buildings, mu-
seums, galleries, 
sports, dance and mu-
sical performances 
present you with pho-
to ops. 
  
Worth spending peri-
ods of time there. 
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HERE’S A THOUGHT 
BY  SUSAN DU BOIS 

 

 

 

 

Do you find that a lot of your photographs lack that little 
something that makes them special? Do they appear cluttered 
and make your eye wander all around the picture without fo-
cusing on anything specific?   

If so, ask yourself a few questions.   

Is everything in the frame necessary and does everything 
contribute to the photograph?  

How much can you take out of the frame through isolation 
techniques?   

Can you change your point of view to shift some of the lines 
and refocus the energy on your main subject?  

What are you trying to communicate?  

 Continued... 
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“A designer knows he has achieved perfection not when there is nothing left to add, but when there is noth-
ing left to take away”. Antoine de Saint-Exupéry. 

Photos by  

Susan Du Bois 

In other words, simplify your images.  The 
more you try to include in the frame, the 
more it weakens your photograph. Decide 
what message you are trying to convey, then 
you will better be able to determine which 
elements are needed in the frame to tell your 
story; then make your photographs as simple 
as possible by removing all extraneous ele-
ments. If you cannot remove the distracting 
elements, can you use a telephoto lens to 
zoom in on your main subject, can you use a 
shallow depth of field to draw and keep the 
eye on your subject, can you shift your posi-
tion to change the leading lines? Remember, 
keep it simple; the expression of emotion is 
based in simplicity.  
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In my first installment of this monthly technical photography article, I would like to intro-
duce you to your light meter. You may have already met, either by chance or as intended 
but whether you knew it or not, the light meter in your camera is a your constant photog-
raphy companion. Understanding what your camera’s light meter does and how it works is 

critical to advancing your skills and helping you get the shots you really want.  
 
So how does your camera measure light and give you or the camera that information to choose the settings that 
allow you to achieve a properly exposed photograph? It does so with its built-in TTL (through the lens) light 
meter. When we point our cameras at any scene, the light meter measures the light in the scene.  
 
Your light meter looks like this ↓↓ 
 

 
 

 

and is found at 
the bottom of 
your viewfinder

 →→ 

 
When our Camera shooting mode is in manual   https://www.lifewire.com/understanding-camera-
shooting-modes-493606  the light meter shows us the amount of light being reflected back through the lens 
to the camera’s sensor on our meter. That visual scale on the light meter disappears in your viewfinder 
when you are shooting in any of the Auto Shooting modes: Example -Aperture Priority, Shutter Priori-
ty, Auto, or Program.  Even in the auto modes -AP(AV), SP(TV), A, P- if the sensor cannot achieve 
proper exposure then the light meter will “suddenly appear” Why? Because the camera is telling you that it 
cannot make the proper exposure so it will show you whether the image will be either under or overex-
posed. 
 
The scale on the meter has a positive and a negative side. Too far to the positive shows OVER exposure 
too far to the negative shows underexposure. Zero or the middle of your meter is neutral and has a bright-
ness of 18% grey. That is considered the balance needed in whites and blacks or highlights and shadows 
for a “proper exposure” 
 
Exposure compensation can be confusing and I don’t have the space to discuss it here except to note that it 
only works to change your settings when you are shooting in the auto modes. In fully manual it does not 
change any of your settings.  

A monthly newsletter article to help you to understand photography and your camera.  
Please contact me at NPCprogramdirector@gmail.com with any questions, to point out 
any mistakes that I may have made or suggestions for future articles.  

LETS GET TECHNICAL  
BY DONNA EDMONDS 

 Continued... 

about:blank
about:blank
about:blank
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Continued:  

METERING MODES 
If you happen to be photographing a scene that’s evenly lit and 
mostly made up of mid-tones you’re likely to end up with a 
well-exposed image. Of course, not all scenes are like that. 
Try shooting something with big contrasts of light and dark 
(sunset or snow) and you may not fare so well! This is when it 
pays to understand camera metering modes so you can take 
control. 
 
 
Metering Modes - By default, the camera meter looks at the 
light levels in the entire frame and comes up with an exposure 
that balances the bright and the dark areas of the image to 
show the most detail. If we change the metering mode we can 
have the camera’s meter only look at certain areas of the frame to come up with an exposure that shows the 
most detail for one part of the image or give one part of the image more weight or importance when calculat-
ing exposure. 
 
Easiet way to change your metering mode. Refer to your manual and then practice changing you camera’s 
metering mode. ↓ ↓     ↓ ↓ 
 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

• Spot - measures a spot or very small area of the image to base the exposure on.  

• Center-weighted - Takes measurements from the center around the centre of the viewfinder . 

• Matrix / Evalutive /Averaging - reads the light of the entire area in the viewfinder by dividing the im-

age into sections. The meter reads the light value coming in from each of these sections and calculates the 

best exposure. 

• Partial – offered on some cameras only – similar to spot metering but with a bigger area. 

← 

← Example of Canon 

Metering Mode Menu 

 And  

 
Continued... 
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Shooting Modes and how your meter works in  
 
 
Fully manual – You choose aperture, shutter speed and ISO – Meter tells YOU when you have “proper ex-
posure” 
 
Manual + Auto ISO – You choose aperture, and shutter speed - Meter tells camera what ISO to choose to 
achieve “proper exposure” 
 
Aperture Priority – You choose aperture - Meter tells camera what shutter speed to choose to achieve 
“proper exposure” 
 
Aperture Priority + Auto ISO – You choose aperture speed Meter tells camera what shutter speed and ISO to 
choose to achieve “proper exposure” 
 
Shutter Priority - You choose shutter speed Meter tells camera what aperture to choose to achieve “proper 
exposure” 
 
Shutter Priority + Auto ISO You choose shutter speed Meter tells camera what aperture and ISO to choose to 
achieve “proper exposure” 
 
Auto – Camera chooses all settings 
 
Program (“P”) Mode The camera chooses your settings but you can adjust them 
 
Camera Preset Auto Modes Meter tells camera what shutter speed, aperture and ISO to choose to achieve 
effects of auto mode parameters. Example: night mode, portrait mode, P, Auto, macro etc.  
 
 
ALL MODES HAVE TO WORK WITHIN THE LIMITS OF THE CAMERA AND THE LENSES 
 
Our best tool is a human brain that can see and actually recognize the scene. Brains and photographers have 
experience to know and recognize the difference; cameras do not. 

https://digital-photography-school.com/understand-camera-light-meter-desired-exposure/#:~:text=Most%
20cameras%20today%20use%20a,is%20exposed%20how%20you%20want.  
 
https://www.photoblog.com/learn/metering-modes/  
 

Editor's Note:  Donna Edmonds is one of the talented people who put together our NPC 

slideshows.  Terry Carpenter, Stan Kicak and Jeannie Gane are the other tech savvy 

people who contribute their talents to slideshow production.   

In the time of Covid-19, you can view our most recent slideshow at :   

https://www.youtube.com/channel/UCqLhPuUuANglDsLVNYJpIGA/featured?

fbclid=IwAR0undOFDTrhOWeVWgYY7Z2TqQtQ9rsv-Ep6v6pMT1uVUbWBnsnd5TZbTZ8 

about:blank#:~:text=Most%20cameras%20today%20use%20a,is%20exposed%20how%20you%20want.
about:blank#:~:text=Most%20cameras%20today%20use%20a,is%20exposed%20how%20you%20want.
about:blank
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Don Komarechka 

An instructional book on macro pho-
tography: 352pg hardcover tome of 
knowledge, techniques and expertise 
with no secrets held back.  

 

To Purchase go to:  
https://www.kickstarter.com/project
s/donkom/macro-photography  

BULLETIN BOARD 
BUY—SELL– ANNOUNCEMENTS 

 

Photography Equipment for Sale 
 

George Dimitroff, friend and fellow Peterborough Photographic Society member, passed away re-
cently and his wife, Sheila, would like to sell his camera equipment. 
 
Anyone interested may call Sheila at 705-748-3535 or email at sadimitroff@gmail.com  
(Posted by Paul Macklin) 

 

Lenses  

Nikon AF-S Micro 105mm 2013  

Tamron 24-70mm G2 2017  

Tamron 70-200mm G2 2017  

Tamron teleconverter 2x 2018  

teleconverter 1.4x 2018  

Speedlights  

Nikon SB-600 x 2 2007  

Yonguo YN685 x4 

Yunguo wireless flash controller/trigger x6 

 Spyder Pro monitor calibration 2015  

Tamron tap-in console for Nikon 2017  

Pixel voical MC50 microphone  

Viewfinder and case  Continued... 

https://www.kickstarter.com/projects/donkom/macro-photography/creator_bio
mailto:sadimitroff@gmail.com
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Photography Equipment for Sale Continued 
 

George Dimitroff, friend and fellow Peterborough Photographic Society member, passed away recently 
and his wife, Sheila, would like to sell his camera equipment. 
 
Anyone interested may call Sheila at 705-748-3535 or email at sadimitroff@gmail.com  
(Posted by Paul Macklin) 

 

Reflector- small round, gold/silver  

large round gold/white  

Westcott umbrella reflector x2  

Lensbaby 2008  

Aputure remote starter  

G3 Camera harness- charcoal grey 2019  

Backdrop stand 2014  

Boomlight stand 2015  

Westcott 8’ light stand x 4 2016  

Photo Paper  

Epson premium luster 10ml thickness –13x32.8 for Epson printers 2017  

HP premium plus high gloss 4” x 6”  

Epson ultra premium- 10 sheets 8.5x 11  

Staples photo basic 8.5 x 11 3 packages sp1400 pgps 2 unopened  

Epson premium 13” x 19” quantity unknown. 2018 

mailto:sadimitroff@gmail.com
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Patrick’s Tips 
By Patrick Romano 

 

 

Hello everyone.   

Hope this newsletter finds everyone safe and well.  Now that we are no longer totally confined to our 

homes I figure we will all be heading to places in the outdoors to practice our photography and with the 

Autumn Season fast coming upon us many Club Members will be going out to record the beautiful land-

scapes around us.   

I will from now on be searching and placing URLs on specific subjects hoping to whet your juices to try 

some of the ideas enclosed.  For this Issue of the Monitor I have chosen posts that may help us photograph 

landscapes.  Take care everyone and have fun out there. 

 

 

How, Why, and When to Use Polarizing Filters  By Kevin Landwer-Johan   Click Here 

 

12 Tips to Help You Capture Stunning Landscape Photos By Kav Dadfar   Click Here 

 

How to Use Photography Filters for Amazing Long Exposure Landscapes  By Simon Bond  
Click Here 

 

How to Predict Dramatic Sunsets  By Bruce Wunderlich  Click Here 

 

5 Tips for Setting the Focus in Your Landscape Photography  By Jim Hamel  Click Here 

https://digital-photography-school.com/polarizing-filters/?utm_source=newsletter&utm_medium=email&utm_campaign=Sep-1720&e=romano.pj@gmail.com
https://digital-photography-school.com/12-tips-to-help-you-capture-stunning-landscape-photos/
https://digital-photography-school.com/photography-filters-amazing-long-exposure-landscapes/
https://digital-photography-school.com/predicting-dramatic-sunsets/
https://digital-photography-school.com/5-tips-for-setting-the-focus-in-your-landscape-photography/
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The Monitor 

 

 

Fall is definitely in the air, with the arrival of cool mornings and evenings.  Although I don’t miss the heat 
and humidity of July and August, I look at my garden and do miss the flowers I have been photographing 
this past spring and summer.  I plant my garden with photography in mind.  I have rediscovered flower 
photography using a combination of the Sony a7iii body and 100mm Canon macro lens.  On earlier at-
tempts I used my Canon 5dMarkIV with the same lens and was never completely happy with my results.  I 
blame my vision not the Canon camera. 

 

The Sony has focus peaking which I find so helpful.  For those not familiar with this feature, you can select 
a colour (either white, yellow or red depending on what will show best on your flower) to highlight the are-
as in your image which are in focus.  Depending on the flower, I take enough images to cover the flower 
head, stem and leaves and focus stack them in Photoshop.  I also shoot at a fairly wide aperture of f/4 
which helps to soften/blur the background.   

 

Focus stacking can be done in several ways like most things in Photoshop.   I use the following method: 

 

File> Scripts> Load Files into Stack.   

Select the Browse button to locate your files.  Select all the files in your sequence and enter OK.  Your 
files will open as layers in Photoshop.   

Select all the layers (files) by holding the Shift Key and selecting each one.   

Select Edit> Auto Align Layers and Auto.   

Once this is complete and again with all images selected, select Edit>Auto Blend>Stack Images 

You will see masks beside each layer – beyond my skill level at this point so I ignore the masks  

At this point I select Layer and Merge Visible 

 

You will now have one file hopefully completely in focus.  A few tips for a successful stack include: 

Make sure it is not too windy out, even if the wind stops I find something will have moved and you 
won’t get a clean image. 

Definitely use a tripod for a sharp end result.  If you are looking for something a little more creative, 
you could try hand holding and take 3 images, moving the focus ring for each.   

For a cut flower, you can use a plamp to hold your flower and move about your yard for a pleasing 
background. 

I always hold my hand in front of the lens at the beginning and end of the sequence.  This makes it easy 
to identify what files are in each sequence. 

 

 

THE LAST PAGE 
BY MOIRA FENNER 
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In addition to Photoshop, there are other stacking software, such as Helicon Focus and Zerene Stacker, both 
of which have free 30-day trial periods.  For my needs, I find Photoshop works great. 

 

If you haven’t tried focus stacking before, this could be something new to try to help keep you busy over the 
winter months. 
 

Executive: President: Bryan Marjoram, Vice President: Brendan Flynn, Secretary: Susan Dubois,  

Program Director: Donna Edmonds, Membership Director: Janet Taylor, Financial Director: Stan Kicak, 

Technical Director: Jeannie Gane, Outings Director: Sandra Peters, Outreach Director: Gerry Atkinson, 

Communications Director: Barbara Husband.  

 

Newsletter co-producers:  Elisabeth La Fontaine, Barb Husband, Moira Fenner, Janet Taylor.  

I digitally paint my flowers 
in Photoshop and this is the 
final painted copy.  

This dahlia is an 11 image focus stack.   


